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MOLECULAR MODELLING EXERCISES 

 

EXERCISE CS6.8  ESTRONE SULPHATASE INHIBITORS 

 

INTRODUCTION 

Various steroids have been studied as potential inhibitors of the enzyme estrone sulphatase. 

Structure IX is active, whereas structure X experiences a drastic drop in activity (Fig. 1). In this 

exercise, we will explore why there is such a difference in activity for such an apparently small 

structural difference.   

 
 

Figure 1  Inhibitors of estrone sulfatase. 

 

 

INSTRUCTIONS 

It is suggested that you attempt the following instructions yourself before carrying out the more 

detailed Procedures that follow. You may find the file entitled Common Operations for 

ChemBio3D/Chem3D a useful guide on how to carry out various operations.  

 

*Build the two structures by modifying the structure of estrone (available as a ChemDraw file in 

the ChemDraw folder).  

*Energy minimize both structures. 

*Identify the most stable conformations for both structures.  

*Compare these and suggest why there is such a difference in activity between structure IX and X. 
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PROCEDURES 

There are various approaches that you can use to tackle these molecular modelling exercises. The 

following procedures illustrate how you might tackle this particular exercise, but they are not meant 

to be prescriptive. Note also that the results obtained may vary depending on the computer and the 

version of ChemBio3D or Chem3D used. For example, the specific conformations obtained from 

energy minimisation may differ, as may quantitative results such as steric energies. 

 

Part A) 

 

1) Create the energy-minimised 3D-structure of estrone. 

 

*Open ChemBio3D or Chem3D. 

*From the File menu, choose Open, then select the relevant ChemDraw file for estrone (available 

in the ChemDraw folder). Click Open.  

*Energy minimize the structure  to get the 3D model of estrone shown in figure 2. The steric 

energy was 23.9 kcal/mol. 

 

 
 

Figure 2  Energy-minimised structure of estrone. 

 

2) Alter the structure of estrone to create structure IX.  

*Copy and paste the structure of estrone into a new window 

*Choose the Text tool .  

*Click on the proton at position 2 and enter C in the text box that appears.  

*Press return on the keyboard and a methyl substituent is created at position 2.  

*This process can be repeated on one of the hydrogen atoms on the new methyl group to provide 

the ethyl substituent.  

*Once the structure is built, carry out an energy minimization (Fig. 3A). The steric energy appears 

in the bottom window as 24.1 kcal/mol. 

An alternative way of modifying the structure of estrone is to choose the bond tool  then drag 

the mouse from the relevant atoms to add the ethyl substituent at position 2.  
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  A      B 

Figure 3 Energy mimimised structures of A) structure IX and B) structure X. 

 

3) Build the energy-minimised 3D model for structure X. 

*From the File menu, select New to create a new window.  

*Copy and paste structure IX into the new window. 

*Choose the text tool .  

*Click on the CH2 carbon of the ethyl substituent. A text box appears.  

*Type O in the text box, then press return on the keypad. The ethyl substituent has now been 

transformed into a methoxy substituent. 

*Energy minimize  the structure. 

The resulting structure (Fig. 3B) has a steric energy of 25.8 kcal/mol.  
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PART B Conformational analysis of the methoxy group for Structure X  

In this part, we will generate 72 conformations resulting by rotating the methoxy group. 

 

1. Set the Preferences for the Dihedral Driver such that a conformation is sampled each time 

the selected bond is rotated 5o. 

*Make sure you are in the window containing structure X. 

*From the File menu, choose Preferences to open up a dialogue box. 

*Click on the tab for Dihedral Driver to open another dialogue box. 

*Use the slider bar to change the resolution to 5o, then choose OK 

 

2. Generate the Dihedral Driver chart by rotating the methoxy group. 

*Choose the select tool . 

*Click on the bond identified in figure 4 to select it. 

 
Figure 4  Conformational analysis involving rotation around the bond highlighted in yellow. 

 

*From the Calculations menu, choose Dihedral Driver, then choose Single Angle Plot. You will 

see the bond rotating. 

*Once the bond has rotated full circle, a chart should appear showing how the steric energy 

changes with rotation round the selected bond (Fig. 5), with conformations sampled every 5 

degrees. If the chart is not visible, choose it from the View menu. If the chart is still not visible, you 

may have to drag down the top margin of the main window to reveal it.   

 

 
 

Figure 5  Dihedral Driver Chart for the rotation of the methoxy substituent in structure X.   

 

The y-axis measures the steric energies of the conformations, while the x-axis measures a dihedral 

angle which defines the conformation. The dihedral angle in question involves the atoms C(2)-

(C1)-O(24)-C(43). The numbers given are serial numbers that are assigned to the structure by the 

program and bear no relation to the IUPAC numbering system.  

3. Identify which atoms are involved in measuring the dihedral angle. 
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Hover the mouse over the atoms of the structure. As you do so, a pop window will appear that 

shows the serial number for that atom. The four atoms involved in the dihedral angle are 

highlighted in figure 6.  

 

 
Figure 6  Atoms used to measure the dihedral angle measured on the chart. 

 

*With the mouse key depressed, use the Select tool to select the four atoms making up the dihedral 

angle as shown in figure 6. 

4. Measure the dihedral angle for the initial energy-minimised structure. 

This is the structure that was used to create the plot. Once the plot has been constructed the initial 

structure is reshown in the main window. 

*Make sure that the four atoms defining the relevant dihedral angle are still highlighted. 

*From the Structure menu, choose Measurements, then choose Display Dihedral Measurement.  

The dihedral angle is 109.8o. This corresponds to the part of the plot with the lowest steric energy. 

 

5. Identify the conformations represented by the two peaks in the plot. 

*Click on the plot line at the top of each peak to identify the different conformations and their steric 

energies. The model in the window will alter to the conformation concerned. Note that all the less 

stable conformations are concentrated between the dihedral angles -45o to 45o. The conformations 

corresponding to the two peaks are shown in figures 7 and 8. The steric energies and dihedral 

angles are displayed on the plot in a pop up window. In both cases, there is a steric clash between 

the methoxy group and the phenol group where hydrogens are too close to each other. 
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Figure 7  Least stable conformation at dihedral angle 25o and steric energy 165 kcal/mol. 

 

 
 

 
 

Figure 8 Conformation corresponding to second highest energy peak at dihedral angle -25o and 

steric energy 139.43 kcal/mol. 

 

6. Identify the energy barrier to free rotation of the bond. 

The energy-minimised structure has a steric energy close to 26 kcal/mol, whereas the least stable 

conformation shown in the plot has a steric energy of 165 kcal/mol. Therefore, the energy barrier to 

rotation is 139 kcal/mol. 

 

7. Identify stable conformations in the plot.  

The chart shown above clearly shows the energy barrier and the sterically strained conformations, 

but makes little distinction between more stable conformations. This is because the high steric 

energies of the least stable conformations dominate the plot. In order to distinguish between stable 

conformations, it is best to rerun the plot with localised minimisation. This eases the steric strain 
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for the least stable conformations by moving apart atoms that are too close together. It is not a full 

energy minimisation, though, and the dihedral angle is unaffected. By relieving strain, the range of 

steric energies on the y-axis will decrease and help to make a clearer distinction between the 

relative stability of the more stable conformations  

 

*Click on the plot line to return the structure to its original conformation with a dihedral angle of 

110o. 

*Position the mouse in the window containing the plot and right click the mouse to produce a 

menu. 

*Choose Recompute with minimisation. The bond will rotate once more as the 72 conformations 

are recomputed. The new plot now shows one energy barrier and a much reduced energy scale (Fig. 

7). Despite the reduced energy scale, there is little distinction between the conformations having 

dihedral angles between -180o and -90o and between 90o and 180o.  

 

 
 

Figure 7  The Dihedral Driver Chart with minimisation. 
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PART C Conformational analysis of the ethyl group for Structure IX  

In Part C, we will repeat the analysis carried out in part B for Structure IX  

 

The Dihedral Driver Chart for structure IX (Fig. 8) was run without minimisation and is almost 

identical to the plot obtained for structure X. The starting conformation is identified as having a 

dihedral angle of 83o, which corresponds to the lowest point on the plot with a steric energy of 

about 24 kcal/mol. The highest energy conformation (Fig. 9) has a steric energy of 96 kcal/mol, 

which means that the energy barrier to rotation is 72 kcal/mol. 

The energy barrier to rotation for structure IX is about half as much as for structure X. 

Nevertheless, the stable conformations cover a similar range of dihedral angles to those obtained 

for structure X, and there is no obvious reason why rotation of this bond should be the reason for 

the different activities for structures IX and X. 

 

 
 

Figure 8  Dihedral Driver Chart for the rotation of the ethyl substituent in structure IX. 

 

 
Figure 9 Conformation of energy-minimised ethyl analogue used to create the plot. 

 

The conformation corresponding to the highest peak in the dihedral driver chart experiences a steric 

clash between the CH2 moiety of the ethyl substituent and the phenol group (Fig. 10). 
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Figure 10  Least stable conformation of the ethyl analogue at dihedral angle -20o and 95.90 

kcal/mol.  
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PART D Conformational analysis of the phenol group for Structure X  

In this part, we will rotate the phenol group of structure X to generate different conformations. 

*Go back to the window containing structure X and ensure that it is in the energy-minimised 

conformation.  

*Select the C-OH bond and create the Dihedral Driver Chart without minimisation (Fig. 11).  

When the C-OH bond is rotated, there is a clear preference for the conformation at dihedral angle 

0o. This can be explained by the possibility of an intramolecular hydrogen bond between the OH 

group and the neighbouring methoxy substituent (Fig. 12). The actual dihedral angle for the energy-

minimised structure is 3.7 degrees, and the steric energy is 26 kcal/mol. 

 

 
 

 

Figure 11  Dihedral Driver Chart for the rotation of the hydroxyl substituent in structure X. 

  
Figure 12  Energy-minimised structure of the methoxy-analogue used to create the plot 

(corresponds to the energy minimum at a dihedral angle between 0-5o . The atoms in yellow define 

the dihedral angles C(1)-C(2)-O(7)-H(27). 

 

The steric energy of the conformer at the other energy minimum is 29.89 kcal/mol (Fig. 13). This 

corresponds to a dihedral angle of 180o where the OH group is pointing the other way and is not 

forming an intramolecular hydrogen bond. The energy difference between the two conformations is 

about 4 kcal/mol. The ratio of conformation one would expect for this difference in energy can be 

calculated using G = -RTlnK, where K represents the equilibrium between the two conformations. 

Using this equation;  

4.00 = -0.002 x 300 lnK 

Therefore lnK = -4/0.6 = -6.67 

Therefore K = 0.0013. 

Therefore the ratio of the two conformations would be 0.0013: 1.00 

This means the percentage populations of the two conformations would be 0.13% and 99.87% 
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Figure 13 Conformation corresponding to the other energy minimum at dihedral angle -180o and 

steric energy 29.89 kcal/mol.  
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PART E Conformational analysis of the phenol group for Structure IX  

*Ensure that you have the energy-minimised conformation of structure IX with steric energy 24.13 

kcal/mol. 

*Generate a dihedral driver chart by rotating the phenol group of structure IX 

When the same study is carried out in structure IX, there is a distinct difference in the dihedral 

angle plot (Fig. 14). In this case, there are two conformations of relatively equal stability at dihedral 

angles 0o and 180o. 

  

 
 

Figure 14  Dihedral Driver Chart for the rotation of the hydroxyl substituent in structure IX 

(resolution 5o). 

 

The dihedral angle use to define the conformations is C(3)-C(2)-O(7)-H(27), which corresponds to 

the atoms highlighted in figure 15B. 

 

   
Figure 15  A) Identification of the bond rotated B) Definition of the dihedral angle measured on 

the chart. 

 

 

2) Identify the two stable conformations of structure IX 

 

*Click on the plot line of the dihedral angle chart at each of the two minima to identify the two 

most stable conformations. The structures are very similar in steric energy and differ only in the 

orientation of the phenol group (Fig. 16).   
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   A     B 

Figure 16 Stable conformations for structure IX. 

 

Figure 16B has the OH group pointing away from the ethyl substituent and corresponds to the more 

stable conformation (Fig. 17). 

 

 

 
 

Figure 17 Position on the chart for the conformation shown in figure 16B  

 

The conformation corresponding to Figure 16A has the OH group pointing towards the ethyl 

substituent and is not so stable (Fig. 18). 

 

 

 
 

Figure 18 Position on the chart for the conformation shown in figure 16A  

 

The difference in energies between the two conformations is 24.14-23.84 = 0.3 kcal/mol 

The percentage populations of the two conformations can be calculated as before  

0.0003 = -0.002 x 300 lnK 

Therefore lnK = -0.0003/0.6 = -0.0005        

Therefore K = 0.9995      

Therefore the ratio of the two conformations would be 0.9995: 1.00 

This means the percentage populations of the two conformations are approximately equal 
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The fact that the ethyl analogue is more active suggests that the conformation having the OH group 

pointing away corresponds to the active conformation. This would make sense if the hydrogen 

atom of this group is acting as a hydrogen bond donor. With the methoxy analogue, the more stable 

analogue has the phenol group locked up in an intramolecular hydrogen bond, preventing it from 

forming an important binding interaction with the binding site. 
 


